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1. YEARBOOK BUILDER 2.5—GETTING STARTED 
 

The Yearbook Builder  makes building professional-looking CD yearbooks easier than 
ever before.  Those who view the final CD-ROM product and experience the multimedia 
presentation of your school highlights will scarcely believe that the yearbook was created 
by students.  
 
That is the whole idea behind Yearbook Interactive – to provide you with the technology 
that allows student teams to produce a dynamic, multi-dimensional publication at a 
professional-quality level. The system teaches them important skills in digital/graphic 
technology, while giving them the satisfaction of seeing the positive results almost 
immediately. 
 
 

1.0. What’s New in Yearbook Builder 2.5? 
If you have used a previous version of the Yearbook Builder software (or 
Yearbook Authoring Software), you will notice below a number of new 
features and enhancements in our latest version—Yearbook Builder 2.5.  

• New and improved Class Portrait section (formerly People section) 
with an integrated Photo Importer/Organizer 

• A variety of Themes from which to choose that gives your yearbook its 
own personality and provides a consistent look throughout 

• An increased number of Layouts and Backgrounds from which to 
choose 

• Photo resizing and “cropping” 
• Electronic signing of yearbooks, one-click emailing, and access to 

student Websites 
• Improved user interface 
• Ability to Import Pages from other yearbook projects allowing for 

many students to create pages at the same time. 
• Significantly faster compiling (up to 400% increase) 
• Larger screen size—800 x 600 pixels 
• Faster search for individual students using the “Find People” tool 
• Ability to Add, Delete, and Rename an unlimited amount of 

Categories 
• Increased text flexibility 
• Enhanced Preview mode 
• Improved Navigation including Previous/Next navigation between 

Categories 
• Student body names displayed on layout pages for faster identification 
• Option to add documents (RTFs) and Web links to pages 
• Includes support for MPEG and AVI media 
• Ability to lock pages to prevent accidental deletion or corruption 
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All of these options allow the student teams to exercise their creativity to the 
greatest extent possible, while allowing the software to do most of the 
technological detail work for them.  

Yearbook Builder is truly the premier product in its class. As you read the 
overview that follows and begin to deploy the software, don’t hesitate to call 
our Customer Service Department if you have any questions. 
 
Customer Service: 
Call Monday through Friday between 7 am ET to 5 pm PT. 
 

Toll-free Phone: 877-463-6924 
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1.1. QUICK START INSTRUCTIONS 
 

1.1.1 CD Setup 
1. Insert CD. 
2. Yearbook Builder Setup will launch automatically. 
3. Click the Next button to run Setup. 
4. When Setup is finished, restart computer. 

(If Windows ’98 Second Edition, run Setup again.) 
 

1.1.2 Getting Started 
1. From the Windows Start menu, select Programs >> Yearbook Builder. 
2. Choose Yearbook Builder 2.5. 

 
1.1.3 Starting a New Yearbook 

1. From the File menu, choose New. 
2. The New Project Setup dialogue box will appear. 

 
1.1.4 Selecting a Theme 

1. In the Yearbook Properties window, enter School Name (e.g. Kennedy 
High School). 

2. Enter Yearbook Title (i.e. We are the Champions, The Titans, etc.). 
3. Select primary and secondary colors. These colors will be used in the 

theme navigation. (Note: Only some themes use a secondary color.) 
4. Select the Theme for the yearbook. The Theme is the style and navigation 

that will be carried throughout the entire book. 
5. The Theme can be changed at any time by going to the Properties menu 

and selecting Yearbook. 
6. When finished, click OK. 

 
1.1.5 The Work Area 

1. Your work area should consist of two windows: The Navigator window 
and the Yearbook window. 

2. The Navigator window is split into two panes: The Yearbook Categories 
pane and the Category Pages pane.  The Yearbook Categories pane is pre-
populated with a number of Categories for your yearbook. Only the 
Categories that are checked will appear in your yearbook. (Note: 
Checking a Category does not automatically insert a Page. A Page must 
be added to the Category for it to be displayed. 

3. The Yearbook window is where you will create your yearbook project. It 
displays the selected Page Layouts. 

 
1.1.6 Adding the First Page 

Before any photos can be placed, text included, or videos attached, a page 
must be created. 

1. Since you must have a main page, the Main category has been selected for 
you.  
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2. To begin adding elements, go to the Page menu and choose Add. 
3. You will be prompted to select a Background. 
4. The Category Backgrounds are organized by type in the left pane. The 

Backgrounds inside those folders are displayed in the top pane. 
5. Select a Background and click OK. 
6. You will then be prompted to choose a Layout for the page. 
7. Choose a Page Layout and click OK. 

 
1.1.7 Adding and Changing Page Contents 

1. On a Page Layout, gray areas represent the places where you may add 
photos and graphics to the page, while the boxes with text in them 
represent areas that are available for text. 

2. To apply a photo or text to a page, double-click on the designated area. 
 

1.1.8 Insert Photo 
1. After double-clicking on a graphic area, click Browse to find an image 

file. 
2. The photo can be adjusted by putting the cursor on the Preview window 

and, while holding down the mouse button, moving the photo as desired. 
3. The photo can also be enlarged with the Zoom slider on the left. 
4. When finished, click OK. 

 
1.1.9 Text Editor 

1. Choose font, size, style, and color for the selected text box. 
2. Enter text in the Text Preview window. 
3. The black/white radio buttons at the bottom left are for preview use only 

(i.e. when using white text choose a black background for previewing 
only). 

 
1.1.10 Adding Page Properties 

1. To add Properties, go to the Properties menu and select Page or click on 
a Page Property icon in your Yearbook window. 

2. You may add Properties by using the Browse button to locate the file for 
each type of Property. 
• Background Audio files must be .wav files. With most installations, 

you can find a few pre-loaded background audio files in the following 
folder on your hard drive: C:\Program Files\ybbuilder\music. You can 
also add your own. 

• Audio files should be in .wav or .mp3 format. 
• Video files should be QuickTime (Indeo5 Codec), MPEG, or AVI. 
• Text files must be Rich Text Format (rtf). 
• Web links can be written in standard browser format (e.g. 

www.yahoo.com). 
3. When finished adding Properties, click OK. 
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1.1.11 Creating New Categories 
1. In the Navigator window, select the parent Category for the new category. 
2. Click on Add Category at the bottom of the window. 
3. Enter the name of the category in the popup window. 
4. When finished, click OK. 
5. Categories can be reordered by changing the number next to the name of 

the category in the Navigator window. 
 
1.1.12 Creating People Sections (Student Portraits) 

The People Sections work differently from the other pages of the yearbook 
because they contain an alphabetical listing of all the students of a 
particular class.   

1. From the Portraits menu, choose Import Portraits. 
2. Browse to the folder on your hard drive that contains the source files for 

your Class Portraits and click Select. 
3. You will be prompted to do one of the following: 

a. Apply Names to Portraits 
b. Import Additional Portraits 
c. Return to Yearbook Window 

4. In the Name window enter the student’s last name, first name, grade, and 
other information. You can adjust the framing of the photo by dragging 
the portrait while holding the mouse button down. When you have 
finished entering information for a student, click Save and the next student 
portrait will appear. 

5. Note: Photos should be .jpg or .bmp format, and ideally 140 x 210 pixels. 
6. After entering all students’ information, click Close. 
7. To create the Page Layout for a Portrait Category, highlight the Category 

(e.g. Seniors). 
8. Go to the Portraits menu, select Page Layout. 
9. Choose a Category Background and click OK. 
10. In the next window, choose a Page Layout and click OK. 

 
1.1.13 Preview Your Yearbook 

1. To preview pages, go to the File menu and choose Preview. 
2. When finished, click on Stop. 

 
1.1.14 Save 

1. Saving the yearbook file will save any changes made. 
2. From the File menu, choose Save. 

 
1.1.15 Compile 

1. Compile prepares the file to be sent to Yearbook Interactive to create the 
finished yearbook CD. 

2. To compile a project, choose Compile from the File menu. 
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1.1.16 Completed Project 
1. Make a backup copy of your yearbook.  
2. You will need to send a copy of the compiled yearbook to Yearbook 

Interactive by mail. 
 
To mail your compiled yearbook: 
a. Make an additional copy of the yearbook on either a CD or zip disk. 
b. Mail it in a padded envelope or box to: 

 
Yearbook Interactive 
Attention: Fulfillment 
2681 Parleys Way, Suite 101 
Salt Lake City, UT 84109 
 

1.1.17 Technical Support 
For technical support call:  (877) 463-6924 
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2. YEARBOOK BUILDER 2.5—USER’S GUIDE 
 

 
2.0. UNDERSTANDING YOUR YEARBOOK STRUCTURE 

Creating a yearbook is simple, especially when you understand how the 
software is structured. Most of the pages you create in your yearbook will be 
standard layout pages. These are pages where you display photos of the 
events, organizations, and candid moments that take place in your school. 
These standard pages are structured into three hierarchical levels:  Yearbook 
Level, Category Level, and Page Level. 
In addition to standard pages, most schools present each member of the 
student body and faculty in the Class Portrait section.  
Class Portraits are usually studio photos of each individual organized by 
grade with their name and other optional information.  
Class Portraits are handled differently than standard pages because they are 
automatically alphabetized and, subsequently, generate the appropriate 
number of pages based on the number of photos provided. 
The following in-depth instructions are organized by 

• Yearbook Level Functions 

• Category Level Functions 

• Page Level Functions 

• Class Portraits 

• Readying Your Yearbook for Publication 
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2.1. YEARBOOK LEVEL FUNCTIONS 

Your School Name, Yearbook Title, Yearbook Colors, and Yearbook Theme 
are all Yearbook Level Properties. They can be selected and changed only at 
this level. The following instructions deal with Yearbook Level functions. 
 

2.1.1 Starting Your Project 
1. From the menu items, select File >> New or click on the CD Book icon 

on the left of your toolbar. You should see a screen like the one below.   
 

 
 

2.1.2 Name and Title the CD Yearbook 
1. Enter your School Name (e.g. Pacifica High School). 
2. Enter your Yearbook Title (e.g. The Best of Times). 

 
2.1.3 Fonts 

1. The look of both your School Name and your Yearbook Title can be 
customized by clicking on the Font button to the right of each of the text 
boxes. By clicking the Font button, the window below should pop up. 

 

 
 

2. In this window, you can select from any font type found on your computer. 
3. Select the size of your text. (Tip: Select a font that is large enough—12 pt 

or greater—to be prominent on your page and small enough to fit in the 
text box designed for that Theme. If the edges of your text are cut off, it’s 
because the font is too large.) 
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4. Choose your text color using the Color Picker or by typing in the RGB 
values.  

5. After customizing the fonts, click OK.  
 

2.1.4 Theme Definition 
1. The Theme is usually a colorful frame or border for your electronic 

yearbook. 
2. There are several Themes provided for you from which to choose. (You 

can view or print out thumbnails of the Themes from the Help menu.) 
3. The Theme serves two purposes. 

a. It gives the yearbook personality and creates a consistent graphical 
look and feel. 

b. It provides the navigation (buttons and links) for the end-user. 
4. Themes apply to the entire yearbook. You cannot choose a Theme for a 

single Page or Category 
 

2.1.5 Choose Theme Colors 
1. Many yearbook Themes allow you to choose a primary and/or a secondary 

color. The selection can be school colors or colors simply for artistic 
purposes. (Note: Not all Themes use primary and/or secondary colors.) 

2. Pick primary and secondary colors for your chosen Theme by clicking on 
the Primary or Secondary buttons. The pop up window below will 
appear. 

 

 
 

3. A basic color can be selected from those displayed on the Color Palette. 
 
To create custom colors: 
4. Move the crosshair pointer to the desired color in the Spectrum window. 
5. Slide the triangle pointer to the desired Brightness level. 
6. For advanced users, you may also enter Hue, Saturation, Luminance, and 

RGB values in their respective boxes. 
7. When finished, click on the Add to Custom Colors button to put the 

desired color on the Color Palette. 
8. Select the desired color and click OK. 
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2.1.6 Select a Theme 
1. Now, select the Theme for the yearbook.  
2. Below is an example of a Theme. 

 

 
 

3. The Theme can be changed at any time by going to the Properties menu 
and selecting Yearbook. 

4. Once you have selected your desired Theme, click Create. 
5. You are now ready to start choosing Categories and creating Pages. 
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2.2. CATEGORY LEVEL FUNCTIONS 
Categories are similar to “chapters” of your yearbook.  They are sections that 
help to organize your yearbook content.  Yearbook Builder comes with 
sample Categories for you. However, you can create your own Categories, 
change the names of Categories, and reorder Categories.  You can even 
create Categories within other Categories.  Backgrounds are a Category 
Level Property.  You can choose or change Backgrounds only at the 
Category Level.  The following instructions deal with Category Level 
functions. 

 
2.2.1 Selecting a Category 

1. Once you have selected your Theme, your project workspace should 
display two windows: the Navigator window and your Yearbook window. 

 
 

 
 

2. The Navigator window is the place where you will activate and create 
Categories for your yearbook. (Consider Categories to be the “chapters” 
of your yearbook.) The Navigator window is split into two panes: The 
Yearbook Categories pane and the Category Pages pane.  The Yearbook 
Categories pane is pre-populated with a number of Categories for your 
yearbook. 

Navigator window 

Yearbook window 
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3. Categories will not appear in your yearbook until you do both of the 
following: 
a. Activate a Category by placing a check in the box next to the 

Category. 
b. Add a Page to that Category. 

 
 

 
 

2.2.2 The “Main” Category 
1. Whether it be a cover page, a title page, or a home page, every yearbook 

has to have a place to start. Your CD yearbook requires you to have a 
Main Category and, subsequently, a Main Page.  

2. This Category is distinguished by the Star icon in the Navigator window 
and has already been activated for you. (See above graphic.) 

3. While the Category has been activated, you will still need to add a Page in 
order to have this Category appear in your yearbook. (See Adding Pages.) 

4. You cannot delete or rename this Category. 
 

2.2.3 Changing Category Names 
1. To edit a Category name, simply click on the Category name, pause, and 

click again. The name should be highlighted in navy blue with your cursor 
blinking at the end. You can now type in the new Category name. 

 

 
 

Activate by checking box 

Highlight Category to edit 

Main Category is pre-selected 
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2.2.4 Moving and Reordering Categories 
1. Categories can’t be moved from one parent Category to the next, but they 

can be moved within their parent Category. (e.g. Jazz Band and Marching 
Band can be moved within the Bands Category, but they cannot be moved 
to the Yearbook Category nor to the Sports Category.)  

2. Moving Categories really amounts to reordering Categories within their 
parent Category. Categories are actually ordered by a number found in the 
brackets at the front of the Category name (e.g. <02>).  

3. Reordering Categories follows the same procedure as 2.2.3 Changing 
Category Names. However, once the Category name is in the Edit mode, 
you only need to change the number in the brackets.  

 

 
 

4. Note: The new Category order will not change in the Navigator window. 
It is only displayed in the Preview mode and the completed project. 

 
2.2.5 Adding New Categories 

1. Highlight the parent Category in which you would like to create your new 
Category. 

2. Click on the Add Category button. This will launch the dialogue box 
shown below: 

 

 
 

3. Enter the new Category Name and click OK. 
 

2.2.6 Deleting Categories 
1. Highlight the Category in the Navigator window. 
2. Click on the Delete button at the bottom of the Category portion of the 

window. 
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2.2.7 Category Properties: Backgrounds 

1. Backgrounds are assigned to Categories.  All Pages in a specific Category 
share the same Background. 

2. To change the background for a specific Category, go to the Properties 
menu and choose Category or click on the Background in your Yearbook 
window. The dialogue box below will appear. 

 

 
 

3. Background types are in the folders on the left. The Backgrounds 
themselves are listed in the top pane.   

4. Select the desired Category Background and click OK.  
5. Note: You can view or print out thumbnails of the Backgrounds from the 

Help menu. 
 
2.2.7.1 Creating Backgrounds 

In addition to using the Category Backgrounds that come with the 
Yearbook Builder, you may create and import your own 
Backgrounds. To do this: 

1. Create a folder for your backgrounds in the following directory: 
C:\Program Files\ybbuilder\Graphics\Backpic. 

2. Create an 800 X 600 graphic in an image editor like Adobe 
Photoshop or Macromedia Fireworks. 

3. Be sure to save the file in the JPEG (.jpg) format. 
4. Save a copy of your image file into your new background directory. 

You will now see your Background in the Category Background 
dialog box. 
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2.3. PAGE LEVEL FUNCTIONS 
Pages are the most important part of your yearbook.  Your Pages display 
your content—photos and text.  To do this, you can choose from a variety of 
provided Page Layouts.  Page Layouts are the formatting of your photos and 
text on the Page.  Pages also contain the access points to Page Properties 
such as video, audio, documents, and Web Links. The following instructions 
deal with Page Level functions. 
 

2.3.1 Starting a new page 
1. To create a new Page, go to the Page menu and choose Add. Or click on 

the Page icon on the toolbar.  
 

2.3.2 First Page in the Category 
1. For the first Page in a Category, you will be asked to choose a Category 

Background as shown in the dialogue box below. 
 

 
 

2. Highlight a type of Background from the list in the left pane. This will 
display several backgrounds. 

3. Highlight one of the Backgrounds to see the preview. 
4. When you find the desired Background, click OK. This will launch the 

Choose Layout dialogue box. Instructions from this point are identical to 
those found in the following section 2.3.3 Adding Pages. 
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2.3.3 Adding Pages 
1. You will be asked to name your page and choose the layout of graphics 

and text as shown in the illustration below. 
 

 
 

2. Type in the Page Name. This name is for identification only in the 
yearbook building process. It will not show up in your final yearbook. (If 
you do not enter a name, a default name will be created for you, e.g. “page 
id 5 {no name}”.) 

3. Choose a Layout from the list in the left pane. A preview of the selected 
layout will appear in the right pane.  (You can view or print out 
thumbnails of the Page Layouts from the Help menu.) 

4. A naming convention has been provided for the Layouts for ease of use in 
locating the appropriate graphic and text layout.  

5. A filename Legend is provided below the file list. 
6. The Layout naming convention is illustrated below: 
 
 
 
 
 

  
 
 
 
 
7. Once you have identified the desired Layout, click OK. 
8. Your page name will now be displayed in the Category Pages section of 

the Navigator window when the proper Category is highlighted. 
9. Your new Page Layout will be displayed in the Yearbook window. 
 

2.3.4 Deleting Pages 
1. Make sure that the Page you wish to delete is displayed in the Yearbook 

window. 
2. Go to the Page menu and select Delete. 
3. You will be warned that the Page will be deleted. If you are sure click 

OK. 
 

 

 

 

Layout Name:   2lnd_1txt_jagged 

Number of graphic boxes 
Style of graphic boxes:  
 lnd = Landscape images 
 prt = Portrait images 
 sqr = Square images 
 mix = Mix of the above 

Number of text boxes 
Descriptor 
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2.3.5 Inserting a photo 
1. You now can modify your page in the Yearbook window. 
2. The areas that are marked out in gray are your designated graphic boxes. 

 

 
 

3. To insert a photo, simply double-click on the appropriate gray box. The 
Insert Photo window shown below will appear. 
 

 
 

4. Designate which image file you want to insert by clicking on the Browse 
button. 

5. The Insert Photo window will only recognize bitmap (.bmp) and jpeg 
(.jpg) files. If you cannot see the file you want to insert, you may need to 
use a photo editor (such as Adobe Photoshop) to convert the file to .bmp 
or .jpg. 

6. The image can be “cropped” by zooming using the Zoom slider and by 
click-hold-ing the photo with your mouse and moving it around.  

 
2.3.6 Modifying the text box 

1. To enter or modify text, double-click on the desired text area and type the 
characters into the provided field.   
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2. You can change the font type, size, style. 
3. The White and Black radio buttons at the bottom left are used to preview 

text. (i.e. Since white text can’t be seen on a white background, you would 
select Black for previewing.) The text preview background will not show 
up on the actual Page. 

 
2.3.7 Page Properties 

1. You may add the following types of Properties to your pages:   
a. Background Audio—Audio that plays automatically upon viewing a 

Page. 
b. Audio—An audio clip a user activates by clicking on the audio link. 
c. Video—A video clip a user activates by clicking on the video link. 
d. Text—A document that a user can access by clicking on the text link. 
e. Web Link (URL)—A hyperlink to a site on the World Wide Web. 

2. To add Properties, go to your Properties menu and select Page or click 
on the Page Properties button in the toolbar. The following dialogue box 
will appear. 
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3. Inserting the various Properties can all be done at the same time or they 
can be added at different times. Specific directions for each type of 
property are provided in the following sections. 

4. When finished with adding Page Properties, click OK. 
 

2.3.7.1. Adding Background Audio Loops 
1. Go to the Properties menu and select Page or click on the Page 

Properties button in the toolbar.   
2. Click on Browse in the Background Audio section to find the desired 

file. 
3. Yearbook Builder  comes with 56 tracks of background music from 

which to choose or you can use your own audio tracks. (There are also 
a number of freeware audio loops that can be found on the Web.) 

4. To use the audio files provided, follow the pathway:  
c:\Program files\ybbuilder\Music.  

5. Note: The Properties window also includes two other boxes: “Enable 
background audio on this page” and “Loop.”  The Loop box recycles 
the selected music selection until the user goes to another category, or 
until another audio segment is reached.  

6. The “Enable background audio on this page” must be checked if, 
when the yearbook is finally assembled, you want to retain the music 
selection you have made. If that box is not checked, then your music 
selection will be lost. 

7. Note that you can create your own background music as well. Just 
save the music in a .wav format file and import it using the process 
above. 

 
2.3.7.2. Adding Audio 

1. Go to the Properties menu and select Page or click on the Page 
Properties button in the toolbar.   

2. Click on Browse in the Audio section to find the desired file. 
3. For Audio files, the Yearbook Builder only supports .wav and .mp3 

files.  
 

2.3.7.3. Adding Video 
1. Go to the Properties menu and select Page or click on the Page 

Properties button in the toolbar.   
2. Click on the Browse button in the Video section to find the desired 

file. 
3. Note: When selecting Video files, Yearbook Builder supports only 

QuickTime® formats (.mov, mpeg, or AVI). (QuickTime® is 
provided through the Yearbook Builder software program as part of 
our license.) 

 
2.3.7.4. Attaching Rich Text Documents 

1. Go to the Properties menu and select Page or click on the Page 
Properties button in the toolbar.   
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2. Click on the Browse button in the Rich Text section to find the desired 
document file. 

3. Note: In order to add a document to your page, your original text 
document needs to be saved in Rich Text Format (RTF). Most word 
processors will allow you to save in the RTF format. 

4. When finished, click OK. 
 

2.3.7.5. Applying Web Links 
1. Go to the Properties menu and select Page or click on the Page 

Properties button in the toolbar.   
2. Enter the Web Address (URL) of the Website to which you want to 

link. The address can be standard browser format (e.g. 
www.yahoo.com or http://www.yahoo.com). 

3. When finished, click OK. 
 

2.3.8 Importing Pages from Other Yearbook Projects 
This feature allows you to import pages from one project to another. This 
enables you to have several individuals working on a CD Yearbook project at 
the same time.  Main Page and Portrait Pages cannot be imported from one 
project to another. You should create these pages in your Master project. 
1. Pages can be imported into the Master Yearbook by going to the Page 

menu and selecting Import Pages. 
2. Find the Yearbook project from which you want to get the page. The 

following dialogue box should appear. 
 

 
 
3. Click on the Category (in the left pane) and then specify the Page (in the 

right pane) and click Import. 
4. Your Imported Page will now appear in your project. 
5. Note: Some pages may seem to lose layout qualities when imported from 

another project. To refresh the view, go to the Properties and select 
Yearbook. In the dialogue box, reselect your Master Theme and click 
OK.  

6. Note: Yearbook Authoring 1.6 project pages cannot be imported into 
Yearbook Builder 2.5 projects. 

 
 

http://www.yahoo.com/
http://www.yahoo.com/


  Yearbook Builder 2.5—User’s Guide 

 Copyright 2002 Yearbook Interactive   21 

2.3.9 Password Protecting Pages of Your Project  
Password Protection can protect pages in your project from being changed 
by unauthorized users. 

 
2.3.9.1. Setting Password Protection 

1. To set your Password, go to the Properties menu and select Password 
Protect. The following dialogue box will appear. 

 

 
 
2. The Enter old password field should be left blank if you have not 

previously entered in a password. Otherwise, enter your previous 
password here. 

3. Enter your New Password in the second and third fields.  
4. When done, click OK. 
 

2.3.9.2. Locking a Page 
5. To Lock a Page, it must first be showing in the Yearbook window. 
6. Go to the Page menu and select Lock. 
7. You will be prompted to enter the Administrator Password. This is 

the password you entered in 2.5.1 #3. 
8. When finished, click OK. 
 

2.3.9.3. Unlocking a Page 
1. To Unlock a Page, it must first be showing in the Yearbook window 

and it must have been previously Locked. 
2. Go to the Page menu and select Unlock. 
3. You will be prompted to enter the Administrator Password. This is 

the password you entered in 2.5.1 #3. 
4. When finished, click OK. 
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2.4. CLASS PORTRAITS 
The Class Portraits section consists of photos of the student body and 
faculty. It is automatically organized by grade and alphabetical order. 
Because these photos are “auto-generated,” the pages in this section are 
created differently than those in the rest of the yearbook.  You cannot add 
Pages to the Class Portrait section because it is done automatically. (The 
Add Page icon will be disabled.) Class Portrait Categories are designated 
by a silhouette in the Navigator window. 
 
Yearbook Portrait sizes are 140 pixels wide x 210 pixels high. While you 
can “crop” photos during the Naming process, it is optimal to have images 
that are 140 x 210. (You can use an imaging program such as Adobe 
Photoshop  to modify files before importing them.) 
 

2.4.1 Importing Class Portraits 
1. Note: Before you can Import Portraits, you are required to Save your 

project. If you have not yet Saved, you will be prompted to do so. 
2. Go to the Portraits menu and choose Import Portraits. The dialogue box 

below will appear. 
 

 
 

3. Find your source files—the original electronic images of the student body 
and faculty. (Original Images are usually found on a CD provided by a 
school photographer or in a directory of scanned photos.) 

4. Select the image files you want to import. You can select one or multiple 
files. (Tip: Select all files by clicking on any file and then pressing Ctrl-A.  
Select multiple in sequence by clicking on the first file and then Shift-
clicking on the last file.  Select multiple random files by using Ctrl-click.) 

5. When you’ve selected all the files you want to import, click Import.  
6. (Your files will be moved into a directory where the files can be 

manipulated specifically for the yearbook without affecting the original 
images.) 

7. A dialogue box will appear and will give you the following three choices: 
c. Apply Names to Portraits—Takes you to the Name Portraits window 

where you can apply Names, Grades, and other information to 
Portraits. 

d. Import Additional Portraits—Takes you back to #2 of this section. 
e. Return to Yearbook Window—Takes you back to your main 

Yearbook window. 
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2.4.2 Name Portraits 

1. Go to the Portraits menu and choose Name Portraits. The following 
dialogue box will appear. 

 

 
 
2. The previously imported portrait files will appear in the preview window. 

(The original file name will appear below the Preview pane.) 
3. You can “crop” the image by using the Zoom slider and by click-hold-ing 

the photo with your mouse and moving it around. 
4. Information must be entered in the required fields. They are as follows: 

! Last Name 
! First Name 
! Grade 

5. The Middle Initial, Email and Text fields are optional.  The Email field 
can be used to capture student’s current email addresses.  The Text field is 
for entering in any miscellaneous information that Yearbook Staff deems 
appropriate. 

6. To apply the information to the photo, click the Save button. This will 
save the information with the photo and will automatically advance to the 
next photo.  

7. Note: Upon Saving, the Grade Category designated for that student will be 
automatically activated (checked) in the Navigator window. 

8. Skip should be used when you don’t have identifying information 
available and you want to get back to the file later. You will have to Close 
and then return to Name Portraits to get back to a skipped file. 

9. Delete should be used when you have a file that doesn’t belong in the 
Class Portrait section. It will delete the file permanently from your 
yearbook directory. 

10. When finished naming and applying additional information, click on the 
Close button. 

11. NOTE:  You cannot include an individual in any of the Class Portrait 
sections without adding a photo.  If you don’t have a photo for a particular 
person, but want to include that person in the section, import a “filler 
photo” image and associate their name to it. 
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2.4.3 Portrait Page Layout 
1. Note: You will not be able to see Class Portraits in your yearbook until 

you choose a  
2. Portrait Page Layout. Conversely, you will not be able to choose a Page 

Layout until you have Imported and Named Portraits for a particular 
Category. 

3. If you have done the above steps, highlight a Class Portrait Category (i.e. 
Seniors.) If Portraits have been designated for this Category, the Category 
will have been automatically activated (as indicated by the checkmark). 

4. Go to the Portrait menu and choose Page Layout.  
5. You will first be prompted to choose a Category Background. The 

following dialogue box will appear. 
 

 
 
6. Background types are in the folders on the left. The Backgrounds 

themselves are listed in the top pane.   
7. Select the desired Category Background and click OK. This will bring 

you to the Portrait Page Layout dialogue box below. 
 

  
 
8. Note: The Page Name can be disregarded for the Class Portrait sections. 
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9. Select a Page Layout from the list in the left pane. 
10. When finished, click OK. 
 

2.4.4 Modify Portraits 
1. To edit the photo or information for any individual in the Class Portrait 

section, first highlight the desired Category in the Navigator window. 
(You must choose a Portrait Category such as Seniors.) 

2. You will see the first Page of the selected Portrait section. (If you do not 
see a page, you either need to Name Your Portraits [see Name Portraits] 
or choose a Portrait Page Layout [see Portrait Page Layout].) 

3. You can move from page to page by clicking on the Pointing Hand icons 
on the toolbar. 

4. Select the Portrait you want to modify and double-click on the photo to 
bring up the Modify window. 

 

 
 
5. Once in the Modify Portrait Information window, you can choose any 

Portrait you want to modify from selecting a name in the People List. 
6. You can edit the text fields or “crop” the Portrait. (See 2.4.2 line #3.) 
7. When modifications have been made to a Portrait, Click Save. 
8. When finished with all modifications, click Close. 
 

2.4.5 Change Portrait Page Layout  
1. Highlight a Class Portrait Category (e.g. Seniors). 
2. Go to the Portrait menu and choose Page Layout. The following 

dialogue box will appear. 
 

  



  Yearbook Builder 2.5—User’s Guide 

 Copyright 2002 Yearbook Interactive   26 

 
3. Select a new Page Layout from the list in the left pane. 
4. When finished, click OK. 
 

2.4.6 Change a Portrait Category Background 
1. Highlight a Class Portrait Category (e.g. Seniors). 
2. Go to the Properties menu and choose Category Background. The 

following dialogue box will appear. 
 

 
 
3. Select a Category Type from one of the directories in the left pane. 
4. Select a new Category Background from the list in the top pane. 
5. When finished, click OK. 
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2.5. READYING YOUR YEARBOOK FOR PUBLICATION  
 

2.5.1 Previewing Your Yearbook 
1. You will be creating your yearbook in Build Mode. The finished yearbook 

will be created in View Mode. If you wish to Preview the View Mode, go 
to the File menu and choose Preview or click on the eyeball icon on the 
toolbar. 

 

 
 
2. When finished Previewing, click on the Stop Sign. 
 

2.5.2 Saving Your Yearbook 
1. Saving the yearbook file will save any changes made. 
2. From the File menu, choose Save. 

 
 
2.5.3 Compiling Your Yearbook 

1. After you have completed your yearbook draft, you can assemble the 
yearbook resources by clicking on File and selecting Compile. The 
software automatically creates a “ybiresource” folder for you, but you will 
specify the location in which it is created. Remember that location. You 
will need it in order to submit your project. 

2. Note: It is important to uncheck or delete all unused pages and categories 
before compiling. 
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2.5.4 Submitting Your Yearbook 
1. First, make a backup copy of your compiled project.  Copy the entire 

ybiresource folder. 
2. You will need to send a copy of the compiled yearbook (ybiresource 

folder) to Yearbook Interactive by mail for replication. 
 
To mail your compiled yearbook: 
a. Make an additional copy of the yearbook on either a CD or zip disk. 
b. Mail it in a padded envelope or box to: 

 
Yearbook Interactive 
Attention: Fulfillment 
2681 Parleys Way, Suite 101 
Salt Lake City, UT 84109 
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